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CUSTOMER RESOURCE OPTIONS 

Supporting users throughout their entire journey of learning model-based systems engineering (MBSE) is 
central to Vitech’s mission. For users looking for additional resources outside of this document, please refer 
to the links below. Alternatively, all links may be found at www.vitechcorp.com/online-resources/. 

 
Webinars 

Immense, on-demand library of 
webinar recordings, including 
systems engineering industry 
and tool-specific content. 

 
 

Screencasts 

Short videos to guide users 
through installation and usage of 
GENESYS.  

 
A Primer for Model-Based 

Systems Engineering 

Our free eBook and our most 
popular resource for new and 
experienced practitioners alike. 

   

 
Help Files 

Searchable online access to 
GENESYS help files. 

 
Technical Papers  

Library of technical and white 
papers for download, authored 
by Vitech systems engineers. 

 
Technical Support 

Frequently Asked Questions 
(FAQ), support-ticket web form, 
and information regarding email, 
phone, and chat support options.  

 

https://www.vitechcorp.com/online-resources/
https://www.vitechcorp.com/webinar-videos-on-demand/
https://www.vitechcorp.com/genesys-screencasts-on-demand/
https://www.vitechcorp.com/mbse-primer/
https://www.vitechcorp.com/mbse-primer/
https://www.vitechcorp.com/resources/GENESYS/onlinehelp/desktop/
https://www.vitechcorp.com/technical-papers/
https://www.vitechcorp.com/technical-support/
http://www.vitechcorp.com/webinars
http://www.vitechcorp.com/screencasts
http://www.vitechcorp.com/mbseprimer
http://www.vitechcorp.com/resources/GENESYS/onlinehelp/desktop/
http://www.vitechcorp.com/technicalpapers
http://www.vitechcorp.com/MySupport/support/default.aspx


DOORS® Connector Guide 

1 

GENESYS DOORS CONNECTOR GUIDE 
The DOORS Connector is a tool for exchanging requirements between GENESYS™ and IBM® DOORS® 
(versions 9.4 through 9.7) through the OSLC interface. For GENESYS and DOORS to exchange data a 
one-time setup and configuration for the DOORS database has to be done. Then each DOORS module 
that is being used must also be configured. Data can then be exchanged as needed between projects in 
GENESYS that contain the DOORS schema extension and DOORS modules with the extended GENESYS 
properties. 

DOORS Web Access and Interop Server Setup and Configuration 
The GENESYS Connector communicates with DOORS using DOORS Web Access feature. DOORS Web 
Access requires that the Redirector Service and Interop Server components be configured to support 
communication. The Interop Server is particularly important to providing communication between 
GENESYS and DOORS. The DOORS and IT administrators supporting your work group accomplish the 
setup and configuration of DOORS Web services. 

The standard DOORS Web Access installation and configuration should be performed, including the 
modification of the core configuration file, festival.xml. This will allow the DOORS Web Access Server to 
communicate with the broker, the license server, and the DOORS database server. 

For example, in a basic DOORS installation, the following lines need to be added to the festival.xml file in 
the <f:properties> section (<ServerName> is the name of your DOORS server): 

Before <f:properties> 
  <f:property name="licence.server.location" value="27000@localhost" /> 
  <f:property name="ForceHttpsForAuthenticationForOAuth" value="false" /> 
</f:properties> 

After <f:properties> 
  <f:property name="licence.server.location" value="27000@localhost" /> 
  <f:property name="published.url.prefix" value="http://<ServerName>:8080/doors/redirector/"/>"/> 
  <f:property name="ForceHttpsForAuthenticationForOAuth" value="false" /> 
  <f:property name="oauth.domain" value="http://<ServerName>:8080/dwa"/> 
</properties> 

Other changes may be needed as well. 

The DOORS redirector service must be configured, including modification of the redirector configuration 
file, doorsRedirector.properties. This will allow DOORS Web Access users to be able to use DOORS 
URLs in the same way as Rational DOORS users. Users can then specify whether to open DOORS URLs 
in a standard client or in the web client. The doorsRedirector.properties file will include changes similar to 
those listed in the table below: 

Before <properties> 
    <comment>Configuration for DOORS Redirector.</comment> 
   <entry key="doors.url.prefix">doors://<ServerName>:36677/</entry> 
</properties> 

After <properties> 
    <comment>Configuration for DOORS Redirector.</comment> 
    <entry key="dwa.url.prefix">http://<ServerName>:8080/dwa</entry> 
    <entry key="doors.enable">true</entry> 
    <entry key="doors.url.prefix">doors://<ServerName>:36677/</entry> 
    <entry key="dwa.enable">true</entry> 
</properties> 

Two steps are required to ensure that the DOORS Web Access services are running correctly. The first 
step ensures that the DOORS client is able to access the DOORS Server. The second step verifies that 
the DOORS Web Access Server is accessible via HTTP. The DOORS Object Number is an important 
attribute in the data exchange between DOORS and GENESYS. This attribute is not exposed using the 
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OSLC framework, so we need to run a service extension to make sure that it is available. The steps below 
will help you confirm that this service has started: 

1. Copy the file getNumber.inc from the GENESYS program folder (default location is C:\Program 
Files\Vitech\GENESYS 2024\Extensions) into the DOORS program folder (default location is 
C:\Program Files (x86)\IBM\Rational\DOORS\9.x\lib\dxl\addins\services). For DOORS 9.7 and 
later, the DOORS program folder is at C:\Program Files\IBM\Rational\DOORS\9.x\lib\dxl\ 
addins\services. The file getNumber.inc contains the code: 

void getNumber(string par) 
{ 
   Buffer b = create() 
   Buffer idBuff = create() 
   Buffer modNameBuff = create() 
 
   b = par 
   int i = contains(b, ',') 
   idBuff = b[0:i] 
   int id = intOf(realOf(tempStringOf(idBuff))) 
   modNameBuff = b[i+1:] 
   Module m = read(tempStringOf(modNameBuff), true) 
   Object o = object(id, m) 
        
   delete(b) 
   delete(idBuff) 
   delete(modNameBuff) 
 
   setDxlServiceResult number(o)   
} 

 

2. Open the DOORS client, go to the Tools menu and select the Edit DXL… command to open the 
DXL Input dialog box. 

3. Copy the contents of the GetNumber Installer.txt file found in C:\Program Files\Vitech\GENESYS 
2024\Extensions. Paste the code into the DXL Input dialog box: 

OSLCDXLService os = null 
string err = null 
string dxlCode = "#include <addins/services/getNumber.inc>\n"   
err = addOrUpdateOSLCDXLService("getNumber", "Get Object Number 

Service", dxlCode, "getNumber")   
if (!null err)  
{  
    print err  
}   
else   
{  
    print "Installed Service\n"  
} 

4. Click Run 

If the DXL Output pane contains "Installed Service", then the DOORS client access is okay. 

Secondly, verify the DOORS Web Access Server is running by navigating with a Web browser to the URL 
“http://<ServerName>:<PortNumber>/dwa”. 
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Provide the server name, <ServerName>, and port number <PortNumber> (8080 by default), to the user, 
since they will be used later to access the DOORS database from GENESYS. 

Establish OSLC Credentials in DOORS 
In the DOORS client, a set of OSLC credentials need to be created in DOORS, which will be used to access 
the DOORS database. To do this, select the File menu, open the OSLC item and select “Local Keys…” 
Click the “Add” button and enter a set of OSLC credentials. The OSLC credentials that need to be entered 
are:  

• Consumer name 
• Consumer key 
• OAuth secret 

The “Consumer name” is the DOORS Username. The OSLC credentials are used in GENESYS to access 
the DOORS database from GENESYS. 

Project Setup – Schema Extensions 
Once all the DOORS services have started for the GENESYS-DOORS Connector, configure the DOORS 
modules that will use the connector. To enable synchronization of the requirements objects in a DOORS 
module with the corresponding entities in a GENESYS project, a set of attributes needs to be added to the 
DOORS module which corresponds to the DOORS schema extensions in GENESYS. GENESYS scans all 
DOORS modules for these attributes, only modules with the following required attributes will be presented 
to GENESYS users for import and export. 

Required DOORS Schema Extension 
For a DOORS module to be accessible from GENESYS, add all of the following attributes to the DOORS 
module. The table below lists the attributes to add to or modify in the DOORS Module. 

Note: See Appendix A, for instructions for versions after 9.5. 

Table 1: Schema Extensions 

Attribute Name Type Attribute 
Scope Uniform Resource Identifier (URI) 

GENESYS ID String Object http://genesys.net/ns/rm/doors/attribute#genesysId 

GENESYS 
Name 

String Object http://genesys.net/ns/rm/doors/attribute#genesysName 

GENESYS 
Class 

String Object http://genesys.net/ns/rm/doors/attribute#genesysClass 

Allocated 
Component 

String Object http://genesys.net/ns/rm/doors/attribute#allocatedComponent 

Basis of String Object http://genesys.net/ns/rm/doors/attribute#basisOf 

Specifies String Object http://genesys.net/ns/rm/doors/attribute#specifies 

Object Heading   http://jazz.net/ns/rm/doors/attribute#objectHeading 

Object Text   http://jazz.net/ns/rm#primaryText 

The attribute name column is descriptive text represented in the DOORS user interface. The URI column 
is critical and provides the binding of the attributes between the two products. The steps used to add the 
Attributes to DOORS are: 
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1. Open the DOORS project to which you wish to connect. 
2. Open the module to be connected. 
3. Select the “Edit” menu and select the “Attributes…” item to open the Attributes Dialog box. Select 

the New button and add the attributes listed to the module. 

Once the DOORS module is configured as described above, close the DOORS module, as we will no longer 
need to access the DOORS module directly. All the data transfer / exchange will be initiated and controlled 
from GENESYS. 

User mapped DOORS Schema Extensions: 
GENESYS Allows users to add custom attribute mappings for each import and/or export. Any attribute in a 
DOORS module, to which the user has both read and write permissions, may be mapped. Custom DOORS 
attributes may be added in the same way that the required DOORS attributes are added. This will make 
them available for mapping on the wizard’s mapping page. The following types are allowed for custom 
import/export attributes: string, float, integer, Boolean, date. 

Required GENESYS Schema Extensions: 
In order for GENESYS to be able to use the information stored in the attributes added to the DOORS 
module, apply the DOORS Connector Schema extension to the GENESYS project. Before making changes 
to the GENESYS project, make a backup using the export command on the GENESYS application menu. 
Once the project backup has been created, import the schema extension using the following steps:  

1. Open the GENESYS project. 
2. Select Import from the GENESYS application menu. 
3. Navigate to the file DOORS Connector Schema.gnsx located in the folder GENESYS 

2024\Extensions. Select “Next.” 
4. The wizard will show you the “DOORS Connector Schema” project. Click “Next.” 
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5. Select the option “Import into Project” and choose your project from the drop-down list. Select 
“Next.” 

 

6. The wizard will warn that you are importing data into a project that contains data. This is correct. 
Select “Import” to start the import of the schema modification. 

 

7. After the Import has been completed you will now see the DOORS-related attributes created for 
the Component, Function, Link, Requirement classes in the GENESYS project. 

These steps extend the GENESYS project schema so that it can now accept requirements from DOORS.  

User mapped GENESYS Schema Extensions: 
The import project is a convenient way to add the required attributes to your GENESYS project for setting 
up the DOORS import and export. If you would like to bring additional attributes into your GENESYS project 
from DOORS in addition to the attributes in the extended schema, you may extend the GENESYS schema 
of the REQUIREMENT, COMPONENT, FUNCTION, LINK, or ITEM class and add the additional attributes. 
The following types are allowed for custom import/export attributes: string, float, integer, Boolean, date. 
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The DOORS modules and GENESYS projects are now ready for data exchange. At this point you should 
log out of DOORS. GENESYS controls the data exchange. 

Importing Requirements into GENESYS 
This section describes how to import DOORS requirements into a GENESYS Project. To start this process, 

select the Import   icon on the DOORS section of the Utilities ribbon in GENESYS. 

 

This will start the DOORS Import Wizard. 

1. Use your DOORS login credentials (username and password) in the first part of the import wizard 
dialog box. Enter the DOORS server name for the host, the DOORS port number (8080 by default), 
the OSLC Consumer Key, and the OAuth Secret to complete the remaining items in the dialog box. 
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2. Once you are logged in, the wizard displays the last module to which you connected. Select the 
“Reload…” button to download all the modules on your server with the schema extension 
configured for GENESYS. If you do not see your module listed, make sure the GENESYS schema 
extensions have been applied to the module. Select the DOORS module you want to import into 
GENESYS and select “Next.” 
 

 

3. The wizard will now display the attributes that have been mapped between your project in 
GENESYS and the selected module in DOORS. The required attributes are mapped for you and 
show up with a lock icon to indicate that they are mandatory and not editable. If there are additional 
attributes you would like to map, click “Add” to add a new mapping. Select “Remove” to delete a 
mapping you no longer want. These mappings are stored with your project in GENESYS. Select 
“Next” when done with the mappings. 
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4. The wizard will now prompt you to choose a package within the GENESYS project. You can create 
a new package if desired. Select “Next.” 

 

5. Next is an option to add relationships between the requirements using the “refined by” hierarchy. If 
selected, this will create parent/child relationships based upon the object number hierarchy in the 
DOORS module (the numbering of each object). Select “Next.” 

 

6. Finally, verify your selections and select “Import.” 
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A results dialog will display the results of the import with details of any conflicts encountered. 

 

When requirements are imported into GENESYS the first time, GENESYS generates a unique GENESYS 
name for each requirement by assigning a default name in the format of Requirement_###. Note that each 
cell of a table in DOORS is considered a separate requirement. 

The data is synchronized in GENESYS to allow for seamless syncing of information exchanged during 
multiple imports / exports of information between the two toolsets. Additionally, in the event that the same 
data is present in two or more DOORS modules, the most recently accessed DOORS information will be 
stored in GENESYS.  

You can see a snapshot of the requirements that were imported from DOORS in GENESYS below. The 
refines / refined by relationship is created based on the Object hierarchy organization in DOORS, if that 
option was selected during import of the data. 
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Exporting Requirements from GENESYS 
The entities within GENESYS to be transferred to DOORS need to be placed in a Package in the GENESYS 
project. To accomplish this: 

1. In Project Explorer, create a new package under the Packages entry in the tree view. 

2. With the package selected, in the Browser, select Edit Entities. 

3. In the upper left pane, navigate to the folder that contains the entities you want to transfer to 
DOORS; select the entities in the Possible Targets pane; click the “Add” button to add them to the 
Targets pane. 

4. When all of the entities have been added, click on the Close button to dismiss the dialog box. A 
screenshot of Requirements packaged in GENESYS for export into DOORS is provided below. 
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Once the entities have been packaged, we can initiate the export:  

1. Open the Utilities tab in GENESYS ribbon and select the Export icon in the DOORS section. 

2. Use your DOORS and OSLC credentials (as described in the Import instructions) to validate your 
access to the DOORS database. 

3. Once the connection and access have been verified, you now see the DOORS Export Wizard with 
the latest DOORS module to which you connected. To see a list of all valid DOORS modules 
available, select the “Reload ALL …” button. Choose the module to export into and select “Next.” 



DOORS® Connector Guide 

12 

If you do not see the module to be exported to, check in DOORS to see that the schema extensions 
have been applied to the module (as detailed earlier in this document) and begin the export again. 
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4. Edit the mappings of attributes between GENESYS and DOORS. Then click “Next.” 

 

5. Select the Package of interest created in the section above. Then click “Next.” 
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6. Verify your selections and click “Export.” 

 

7. Once the export is completed, the wizard will show you a results dialog which will give you a 
summary of the changes made and a list of any conflicts. 
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The DOORS module will now have the entities from GENESYS. The screen capture below shows a section 
of the GENESYS attributes that were exported into DOORS. 
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APPENDIX A: MAPPING GENESYS ATTRIBUTES AFTER VERSION 9.5 
 
DOORS version 9.6: 
Depending on which minor version you have installed, DOORS version 9.6 uses one of several methods 
to setup OSLC server links. If you have 9.6 installed, you will need to use either the 9.5 or 9.7 setup 
methods. Version 9.6.1 of DOORS is broken, and the URI cannot be mapped; if you have this version, you 
will not be able to use the GENESYS – DOORS connector. 
 
DOORS version 9.7: 
With the DOORS module open, select Edit | Attributes … command from the module menu. For each 
highlighted entry in Table 1 Schema Extensions, add a new entry to the table by pressing the “New…” 
button and filling out the resultant Attribute dialog. Note that you will not be able to add the URI value at this 
time. Save and close the module. 
 
In the main DOORS client, select File | Mappings … command, make sure the “Attributes” tab is selected. 
For each highlighted entry in Table 1 Schema Extensions, press the “Add…” button. From the dialog that 
appears, navigate to the module you have added the attribute to and select it, and then press the “OK” 
button. The attribute will appear on the list on the “Attributes” tab page. To add the attribute’s URI, select 
the attribute and press the “Edit” button. 
 
Once all of the required attributes are added on the “Attributes” page, select the “Reportable Shape” tab. A 
tree view of all the added attributes will be presented. Select all of the recently added attributes in the tree 
view. Press the “Apply” button. 
 
On the same dialog, select the “General” tab. Find the “Publish” button and press it. Anytime you make a 
change to the attributes, you must press this button before the changes are made externally. 
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